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1.1 Sissejuhatus 

 

Copernicus on Euroopa Liidu kaugseireprogramm, mida koordineerivad Euroopa Komisjon ja Euroopa Kosmoseagentuur (ESA). 
Programmi selgrooks on satelliidiperekond Sentinel. „Sentinel” tähendab saksa keeles „valvur”. Sentineli satelliidid jälgivad meie 
planeedi eri aspekte ja saadavad olulisi keskkonna- ja kliimaandmeid. 

 

Peaaegu iga Sentineli missioon koosneb mitmest identsest satelliidist, millest kaks on samal ajal orbiidil. Kahte satelliiti 
kasutatakse sellepärast, et saada sama asukoha kohta pilte sagedamini. Seega võib Sentineli satelliite kirjeldada kui võimsat 
võrgustikku, mis kogub pidevalt andmeid meie planeedi kohta ning aitab paremini mõista ja hallata olulisi keskkonna- ja 
kliimaküsimusi. 

Sellesse võrgustikku kuuluvad: Sentinel-1, Sentinel-2, Sentinel-3, Sentinel-5P ja Sentinel-6 missioonid. Käesolevas brošüüris 
kirjeldatakse Sentineli missioonide põhijooni ja eesmärke. 

 

1.1.1 Sentinel-1 

Sentinel-1 on esimene kuuest missioonist ja see kogub andmeid järgmiste valdkondade kohta: keskkond, liiklus, majandus ja 
julgeolek. Andmeid kogutakse maa- ja veepinna kohta umbes 700 kilomeetri kõrguselt. Esimene satelliit Sentinel-1A saadeti 
orbiidile Prantsuse Guajaanas 3. aprillil 2014, millele järgnes Sentinel-1B 25. aprillil 2016. Viimane asendatakse alates 5. 
detsembrist 2024 Sentinel-1C-ga. 

Peamine instrument Sentinel-1-l on sünteetilise avaga radar (SAR), millega saab teostada mõõtmise ka läbi pilvede ja öisel ajal. 
Päikese-sünkroonne satelliit võib anda reaalajas pilte üleujutustest, õlireostustest, pinnase liikumisest ja taimestiku tihedusest. 
Sentinel-1 on ainuke Euroopa satelliit, mis annab loodusõnnetuste korral operatiivset infot. 

Joonisel 1 on näha Sentinel-1A tehtud satelliidipilti Hollandis IJsseli järvel asuvast Fryslâni tuulepargist, mida peetakse maailma 
suurimaks magevee tuulepargiks (töötab alates 2021. aastast). 
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Joonis 1: Hollandis IJsseli järvel asuv Fryslâni tuulepark. 

1.1.2 Sentinel-2 

Sentinel-2 on spetsialiseerunud taimestiku ja veekogude vaatlustele. 786 km kõrguselt suudab satelliit koguda väga hea 
resolutsiooniga andmeid, millega saab täpselt tuvastada taimestiku muutusi. 

Esimene Sentinel-2A satelliit saadeti orbiidile 23. juunil 2015. Kaks aastat hiljem, 7. märtsil 2017, järgnes Sentinel-2B. 5. septembril 
2024 startis Sentinel-2A järglane Sentinel-2C, mis on sellest ajast saadik edastanud pilte. Tulevikus on kavas orbiidile saata veel 
kaks satelliiti: Sentinel-2D aastal 2028 ja uue põlvkonna satelliit aastal 2033. Kõik satelliidid saadetakse orbiidile Prantsuse 
Guajaanast. 

Need satelliidid koguvad andmeid nii nähtavas kui infrapuna spektris. Peamine vahend on multispektraalne instrument (MSI), 
mis kogub andmeid satelliidipiltide jaoks kõrgresolutsiooniga. Need aitavad koostada saagiprognoose, kaardistada puistuid ja 
hinnata taimede kasvu. Satelliidid edastavad andmeid pinnamuutuste, metsade, põllumajanduspiirkondade, järvede ja 
rannikualade kohta. Sel viisil saab Sentinel-2 aidata kaasa ka riskide hindamisele ja katastroofide ennetamisele. Satelliidid jälgivad 
ka biofüüsikalisi parameetreid nagu lehtede klorofüllisisaldus ja veesisaldus.  

Sentinel-2 andmeid kasutatakse järgmistes valdkondades: veekogude seire, maismaa seire, metsandus, ilmaprognoos, 
kliimamuutused, turvalisus, georessursid ja georiskid. 

Joonisel 2 on näha Sentinel-2 poolt 17.01.2024 tehtud pilt, mis näitab murettekitavalt madalat veetaset Kataloonia kaitsealal Sau 
veehoidlas. Tavapärast veepiiri näitavad taimestikuvabad kaldaalad. 
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Joonis 2: Sau veehoidla murettekitavalt madal veetase.  

(https://www.copernicus.eu/en/media/image-day-gallery/sau-reservoir-worrisome-water-levels) 

1.1.3  Sentinel-3 

Euroopa Kosmoseagentuuri missioon Sentinel-3 mängib olulist rolli keskkonnaseires. Sentinel-3A saadeti orbiidile 16. veebruaril 
2016 ja Sentinel-3B 25. aprillil 2018. Mõlemad satelliidid saadeti orbiidile Loode-Venemaal asuvalt Plessetski kosmodroomilt. 
Sentinel-3C on kavas orbiidile saata 2026. aastal. Sentinel-3D aga 2028. aastal. 

Sentinel-3 töötati algselt välja ookeanide vaatlusteks. Eri instrumentide vaatlusi kombineerides on võimalik määrata ookeanide 
värvi, temperatuuri ja veepinna taset. Nendest tulemustest on võimalik saada infot ookeanihoovuste, lainekõrguste ja toitainete 
jaotuse kohta. 

Lisaks annab Sentinel-3 ka olulist infot maismaa kohta. Sentinel-3 peal oleva mere ja maismaa kiirgustermomeetri (SLSTR) abil 
saab maapinna temperatuuri mõõta muljetavaldava täpsusega. SLSTR-seade mõõdab Maa pinnalt eralduvat soojuskiirgust 
üheksas erinevas spektriribas. Tulemus teisendatakse temperatuuri väärtusteks. 

Kokkuvõttes aitab Sentinel-3 kaasa keskkonnamuutuste varajasele avastamisele ja annab teavet maakasutuse kohta. Selle abil 
saame välja töötada paremad Maa kaitsmise viisid.  

Joonisel 3 on näha Sentinel-3 poolt jäädvustatud vulkaanipurse Islandil Reykjanesi poolsaarel. Pilt on tehtud 14. jaanuaril 2024, 
ainult mõni tund pärast vulkaanipurske algust. 

https://www.copernicus.eu/en/media/image-day-gallery/sau-reservoir-worrisome-water-levels
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Joonis 3. Sentinel-3 poolt jäädvustatud vulkaanipurse 14. jaanuaril 2024 Islandil. See oli juba teine vulkaanipurse Reykjanesi 
poolsaarel vaid mõne nädala jooksul. (https://www.copernicus.eu/en/media/image-day-gallery/second-volcanic-eruption-
icelands-reykjanes-peninsula-just-few-weeks) 

1.1.4 Sentinel-5P 

Täht P tähistab eelkäijat, st Sentinel-5P-le järgneb Sentinel-5. Sentinel-5P on iseseisev satelliit, aga Sentinel-5 saab olema 
instrument teise satelliidi pardal. 

Sentinel-5P startis Plessetski kosmodroomilt 13. oktoobril 2017. Sentinel-5P keskendub Maa atmosfääri jälgimisele, annab 
teavet õhukvaliteedi, osooni ja UV-kiirguse kohta. Mõõdetakse näiteks ka tervisele kahjuliku gaasi lämmastikdioksiidi 
kontsentratsiooni troposfääris. Joonisel 4 on näha NO2 kontsentratsiooni Euroopas 22. märtsil 2022. Selle põhjal võiks teha 
järeldusi õhukvaliteedi kohta paljudes Euroopa piirkondades.  

 

Joonis 4. Õhukvaliteet Euroopas 22. Märtsil 2022 (https://www.copernicus.eu/en/media/image-day-gallery/air-quality-europe-
22-march-2022) 

https://www.copernicus.eu/en/media/image-day-gallery/second-volcanic-eruption-icelands-reykjanes-peninsula-just-few-weeks
https://www.copernicus.eu/en/media/image-day-gallery/second-volcanic-eruption-icelands-reykjanes-peninsula-just-few-weeks
https://www.copernicus.eu/en/media/image-day-gallery/air-quality-europe-22-march-2022
https://www.copernicus.eu/en/media/image-day-gallery/air-quality-europe-22-march-2022
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Lisaks edastab 5P teavet selliste kasvuhoonegaaside kohta nagu CH4 (metaan), millel on kliimamuutustes väga oluline roll. 
Sentinel-5P suudab koguda teavet ka vulkaanituha asukoha ja koguse kohta.  

1.2 Mis on Maa seire ja mida saab sellega teha? 
Kuidas me teame nii palju kliimast, linnade kasvust, taimestikust või looduskatastroofidest? Kuidas saab kaardistada erinevaid 
maapindu nagu kõrbed või vihmametsad? Satelliitide abil saame teha kõike seda ja palju muud. Maa seire on maapinna, selle 
ökosüsteemide ja atmosfääri uurimine kosmosest. Kaugseire või Maa seire satelliidid tiirlevad ümber Maa ja edastavad 
regulaarselt andmeid, mida seejärel maa peal analüüsitakse. Näiteks saab andmeid kasutada digitaalsete kaartide loomiseks või 
ilma prognoosimiseks. 

Maa seirel on väga palju rakendusvaldkondi. Muuhulgas on võimalik tuvastada muutusi maismaal, veekogudes ja atmosfääris. 
Maa seire satelliidid annavad katastroofi korral aktuaalset infot ja võimaldavad meil abi koordineerida.  

Satelliitide abil võib uurida ka linnade kasvu, merepinna tõusu ja kliimamuutusi. Satelliidiandmed on abiks otsuste tegemisel, 
näiteks uue rahvusvahelise kliimakaitse lepingu koostamisel või olemasolevate lepingute ajakohastamisel. 

Lisaks tihedale koostööle Euroopa Kosmoseagentuuriga (ESA), teeb Copernicuse programm koostööd ka näiteks Euroopa 
Meteoroloogiasatelliitide Kasutamise Organisatsiooniga (EUMETSAT), Euroopa Keskpika Ilmaennustuse Keskusega (ECMWF), 
ELi ametitega ja mittetulundusühinguga Mercator Ocean. 

1.2.1 Maa seire ajalugu 

Maa seirega hakati tegelema Esimese maailmasõja ajal, kui just kasutusele võetud lennukid võimaldasid teha aerofotosid. 
Kaugseiret kasutati vaenlase positsioonide, vägede ja nende tugevuse jälgimiseks. Järgmine suur arenguhüpe kaugseires toimus 
Teise maailmasõja ajal. Näiteks otsiti rannikul maandumiskohti aerofotode abil ja infrapunafilmilindi kasutamine võimaldas 
eristada taimestikku ja kamuflaaživõrke. 

1960. aastatel töötati välja filmilindid taimestiku eri tüüpide tuvastamiseks. Peagi arendati välja radarisüsteemid, mis esialgu 
paigutati lennukite külge. 1960. aastal saadeti kosmosesse esimene ilmasatelliit: TIROS 1. 1972. aastal võeti kasutusele esimene 
luuresatelliit: Landsat 1. Satelliit oli varustatud uut tüüpi anduriga ja tingis uute standardite kehtestamise. Copernicuse programm 
käivitati 1998. aastal. Praegu on Copernicus üks tähtsamaid Maa seire programme maailmas. 

1.2.2 Maa seire rakendusvaldkonnad 

Millistes valdkondades kaugseire andmeid kasutatakse? 

Maakasutuse muutuste tuvastamine 

Maismaa, mere ja õhu teabe kogumine 

Üleilmsete kliimamuutuste mõju uurimine 
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Geodeesia, meteoroloogia, geoökoloogia, keskkonnateadused, säästev areng jne 

Kliima- ja atmosfääriuuringud (sealhulgas ilmaennustus) 

Maapinna liikumine 

Kodanikukaitse 

Julgeolekusektor 

Mere- ja õhusaaste seire 

Katastroofide ennetamine 

Maastiku- ja linnaplaneerimine (maakasutus, maanteeliiklus, müra kaardistamine) 

Ressursside haldamine 

Keskkonnakaitse ja looduskaitse 

Jne... 

 

1.2.3 Sensori ajalugu 

1960. aastatel hakati tasapisi tegelema kosmosetööstuse disaini teemaga ning selle kallal töötasid mitmed teadlased ja 
ettevõtted. Virgina T. Norwood töötas ettevõttes Hughes Aircraft Company ja üks tema ülesannetest oli jälgida, milliseid uusi 
projekte NASA (Ameerika Ühendriikide kosmoseagentuur) kaalub. Seega ta teadis, et NASA töötab satelliidipõhiste 
multispektraalsete piltidega. Norwood kogus kokku erinevate valdkondade eksperdid ja hakkas koos töörühmaga tegelema 
sama valdkonnaga. 

Esimesel NASA Landsati satelliidil oli instrument nimega Return Beam Vidicon (RBV) (elektrooniline pildistamisseade). Seda 
tehnoloogiat hakati kasutama ka TIROSi ilmasatelliitidel ja Surveyori missioonidel Kuul. RBV on sarnane tavakaameraga. Kuid 
sel oli mõned piirangud ja Norwoodi meeskonna ülesandeks sai uue kosmoseskanneri loomine. 

Norwood jätkas multispektraalse (MSS) skanneri disainimist Hughesi inseneri Jack Lansingiga. MSS skaneerib pildi satelliidi 
edasiliikumisel rida-realt. Pärast mõningaid probleeme ja täiustusi loodi toimiv MSS-skanner. (Digitaalsed) MSS andmed 
täiustasid oluliselt satelliitkaugseiret ja digitaalset Maa seiret. 
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23. juulil 1972 käivitati Landsat 1 koos RBV ja MSSiga. Kui esimesed pildid kaks päeva hiljem saabusid, olid teadlased, insenerid 
ja tehnikud pildi kvaliteediga väga rahul. Andur näitas stabiilset jõudlust nii geomeetriliselt kui ka radiomeetriliselt. Landsati 
programm oli NASA ja USGSi (Ameerika Ühendriikide Geoloogiateenistus) kõige olulisem koostöö. 

Lugege rohkem Virginia T. Norwoodist siit (ingliskeelne): https://landsat.gsfc.nasa.gov/article/virginia-t-norwood-the-mother-
of-landsat/  

1.3 Maa seire klassiruumis 

1.3.1 Sissejuhatus 

Maa seire on tähtis teema ja muutub tulevikus üha tähtsamaks. Seepärast on selle valdkonna tutvustamine õpilastele väga 
oluline ja annab neile tuleviku jaoks ka praktilisi oskusi. Seda võib kasutada erinevate ainete raames, eelkõige geograafia ja 
füüsika tundides. Samuti saab läbida seda teemat keemia, matemaatika ja bioloogia tundides ning ainete omavahelise sidususe 
tõstmiseks.  

1.3.2 Maa seire eelised klassiruumis 

Õpetamine ja õppimine... 

Maa seire Maa seire kaudu ... koos Maa seirega 

Vahendid ja meetodid Ruumiline mõtlemine Uurimuslik õpe 

Teadusuuringud Andmetöötlus Teaduspõhine õpe 

Teadusharud Kriitiline mõtlemine Probleemõpe 

Kutsealane areng Analüütiline mõtlemine Tehniliste oskuste arendamine 

 Kodanikuühiskonna liikmeks 
kasvamine 

 

Mida on Maa seirega võimalik 
jälgida? 

Milliseid üldoskusi omandatakse? Kuidas saab Maa seiret kasutada 
õppevahendina? 

Maa seire õpetamisel õpetame ka palju muud! 

https://landsat.gsfc.nasa.gov/article/virginia-t-norwood-the-mother-of-landsat/
https://landsat.gsfc.nasa.gov/article/virginia-t-norwood-the-mother-of-landsat/
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Maa seire õpetamine mitte ainult ei tutvusta vahendeid ja meetodeid, vaid annab ka ülevaate erinevatest erialadest ja 

praegustest uurimistulemustest. Niimoodi arenevad õpilaste praktilised oskused ja teadmised Maa seire võimaluste kohta. Maa 

seire kaudu õppimine arendab selliseid olulisi oskusi nagu ruumiline mõtlemine, meediapädevus ning kriitiline ja analüütiline 

mõtlemine. Maa seire kasutamine klassiruumis võimaldab uurimuslikku, teaduspõhist ja probleemipõhist õppimist, lisaks 

arenevad üldoskused. 

Kaugseire andmed on väga päevakajalised. Õpilased saavad mõne valdkonna probleemide lahendamisega tegeleda praktiliselt 

reaalajas. Teiseks annavad satelliidipildid hea võimaluse jälgida mingit probleemset valdkonda linnulennult, õpitakse analüüsima 

nähtusi eri vaatenurkadest ja areneb ruumiline mõtlemine.  

Maa seire motiveerivat mõju klassiruumis ei tohiks alahinnata. Põnevate satelliidipiltide ja kaasaegse tehnoloogia kombinatsioon 

köidab õpilasi emotsionaalselt ja stimuleerib nende uudishimu. Interdistsiplinaarne lähenemine edendab terviklikku mõistmist 

ja annab õpilastele võimaluse rakendada oma teadmisi erinevates kontekstides. Kaugseire teemaga tegelemine arendab ka 

õpilaste võimet teha iseseisvat tööd ja arenevad nende metoodilised oskused. Need oskused ei ole olulised mitte ainult 

igapäevases koolielus, vaid ka hilisemas akadeemilises ja kutsealases arengus. 

Andmete aktuaalsus, ainulaadne perspektiiv, motiveeriv mõju ja mitmekülgne rakendatavus omavad suurt didaktilist lisaväärtust. 

Maa seire kasutamine klassiruumis võimaldab seega terviklikku ja praktilist haridust, mis rikastab õpilasi mitmel viisil. 

1.4 Maa seire haridusprojektid 

1.4.1 Copernicuse Akadeemia 

Copernicuse Akadeemia loodi Euroopa Komisjoni eestvedamisel ja see seob omavahel Euroopa ülikoolid, teadusasutused ja 
ettevõtluskoolid nii programmis osalevates riikides kui ka mujal. Üldeesmärk on luua side teadusasutuste ning riigiasutuste ja 
teenuseosutajate vahel. Selleks toetatakse ühist teadustegevust ning luuakse uusi loenguid, koolitusi, praktikavõimalusi ja 
õppematerjale. See annab järgmise põlvkonna teadlastele ja ettevõtjatele vajalikud oskused Copernicuse andmete ja 
teabeteenuste parimaks kasutamiseks. 

Copernicuse Akadeemia pöörab tähelepanu ka interdistsiplinaarsele koostööle loodusteaduse, tehnoloogia, inseneriteaduse, 
matemaatika, humanitaarteaduste ja teiste valdkondadega. Toetatakse Copernicuse andmete ja teabe kasutamist 
mitmesugustes avalik-õiguslikes ja eraõiguslikes asutustes. Copernicuse Akadeemia edendab aktiivselt koostööd 
haridusasutuste ja ettevõtjate vahel, et innovatsioon jõuaks kiiresti turule ning tooks seega kasu Euroopa kodanikele ja Maa 
tulevikule. 

Euroopa kosmosestrateegia lahutamatu osana püüab Copernicuse Akadeemia välja töötada ka uusi vahendeid, edendada 
teadmiste jagamist ja tugevdada koostööd eri tasanditel. Copernicuse Akadeemial on oluline roll ka õpilaste ettevalmistamisel 
tänapäeva maailma erinevateks väljakutseteks. 
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1.4.2 Cop4Schools 

Copernicuse Akadeemiasse kuulub liikmeid üle kogu maailma. Programmi liige on ka Ruhr-Universität Bochumi geograafia 
instituudi interdistsiplinaarse geoinfoteaduste töörühm. Töörühm viib ellu mitmesuguseid haridusprojekte, millest üks kannab 
nime „Cop4Schools“ ja mida toetab Copernicus. Selle projekti keskmes on Maa seire teema viimine kooli õppekavasse. 
Töötatakse välja õppematerjale, mis seovad Maa seiret erinevate õppeainetega. Projektis tegeldakse kliimamuutustega seotud 
katastroofide ennetamise teemaga. 

Projekti materjalid on kättesaadavad töörühma loodud veebisaidil „Kaugseire koolides“ (https://fis.rub.de/). Sealt leiate ka 
õppematerjale mitmesuguste teemade kohta teistest projektidest, mis on pühendatud teemale „Maa seire klassiruumis“. 

2 – Lühidalt Maa seirest 

2.1 Mis on Maa seire? Kaugel ja samas lähedal. 

Väga lihtsalt öeldes on Maa seire meie planeedi jälgimine ja enamasti tehakse seda kaugelt. Kaugseireks nimetatakse eemal 
asuvate objektide kohta informatsiooni hankimist mittekontaktsete meetoditega. Enamasti tähendavad Maa seire ja kaugseire 
sama asja. Siiski võib Maad seirata ka maa pealt, seda tehakse kaugseire andmete kontrollimiseks.  

Selles peatükis vaatleme Maa seire meetodeid ja vahendeid. Joonisel 5 on toodud lihtsustatud kujul Maa seire süsteem. 

 

Joonis 5. Kuidas Maa seire toimib? 

Maa peal olevatele objektidele langevad päikesekiired, mida peegeldatakse. Neid peegeldunud kiiri saab satelliitide abil kinni 
püüda ja salvestada. Saadud andmeid analüüsitakse arvutite abil. 

Astronoomias jälgitakse ja uuritakse universumit koos oma planeetide, tähtede ja teiste taevakehadega. Maa seire on sarnane: 
samamoodi jälgitakse oma uurimisobjekti kaugelt, ilma kontaktita. Kuid uurimisobjektiks ei ole mitte avakosmos, vaid Maa ise!  

Maapinna uurimiseks on lennukite ja satelliitide külge kinnitatud mõõteseadmed (sensorid). Need püüavad kinni 
elektromagnetlaineid ja seejärel salvestavad need pildina. 
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2.2 Kuidas Maa seire töötab? 

Maa seires kasutatakse Maa pinnalt peegeldunud päikesevalgust. Aga kuidas see töötab? Sageli nimetame päikesevalgust 
„päikesekiirteks“. Tegelikult pole see päris korrektne. Oma eriliste omaduste tõttu peaksime neid pigem nimetama 
„päikeselaineteks“. 

2.2.1 Pikad ja lühikesed lained 

Põhimõtteliselt on lained vibratsioonid, mis transpordivad energiat. Seda on lihtne mõista, kui mõtlete vette visatud kivi peale, 
mille ümber tekivad lained. Päikesevalgust nimetatakse elektromagnetlaineks, mis erinevalt vee- või helilainetest ei vaja 
liikumiseks sellist keskkonda nagu vesi või õhk.  

 

Joonis 6. Elektromagnetlained kõrgetel ja madalatel sagedustel. 

Nagu ülaltoodud joonisel näha, on lainel hari ja nõgu. Kahe harja vahelist kaugust nimetatakse lainepikkuseks. Laine sageduseks 
nimetatakse suurust, mis näitab, mitu lainet (või võnget) läbib teatud punkti ajaühikus. Mida väiksem on lainepikkus, seda 
suurem on elektromagnetlaine sagedus ja energia. 

Elektromagnetlainetel on ka teisi omadusi. Mingile pinnale jõudes need peegelduvad, neelduvad või kanduvad 
edasi. 

2.2.2 Elektromagnetspekter 

Selleks, et satelliitidega saaks Maad seirata, on vaja mõõteseadmeid. Neid nimetatakse anduriteks. Andurid salvestavad 
elektromagnetlaineid ja annavad välja pilte, mida saab hiljem analüüsida. Elektromagnetlained võivad olla väga erinevad (vt 
joonis 7).  
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Joonis 7. Elektromagnetspekter. 

Päikesevalgus, nagu ka teised elektromagnetlained, võivad peegelduda ja neelduda. Peegeldumise korral liiguvad lained 
pinnast eemale; neeldumise korral aga muundatakse soojusenergiaks. 

2.2.3 Mis on peegeldumine? 

Peegeldumine tähendab, et peale pinnaga kohtumist liigutakse pinnast eemale. Näiteks kui pall visatakse vastu seina ja see 
tuleb tagasi, siis see peegeldub. Sama juhtub päikesevalgusega, kui see jõuab maapinnani. Kui pind on sile, siis langemisnurk 
= peegeldumisnurk. Langemisnurk on langeva valguskiire ja pinna vaheline nurk, peegeldumisnurk on peegeldunud valguskiire 
ja pinna vaheline nurk. 

Mittehajusa peegeldumise põhimõtet on kujutatud joonisel nr 8. Üldiselt eristatakse kolme tüüpi peegeldumist. Objekti pinna 
karedus määrab ära, milline nendest on kõige olulisem. 

1. Mittehajus peegeldumine toimub siledate pindade korral; siis langemisnurk = peegeldumisnurk. 

2. Hajus peegeldumine toimub karedate pindade puhul; siis peegeldub valgus ühtlaselt kõikides suundades. 

3. Segapeegeldumine on omane looduslikule aluspinnale (nt metsad); siis peegeldub valgusvihk kõikides suundades 
ebaühtlaselt. 

 

Joonis 8. Kolme tüüpi valguse peegeldumine. Segapeegeldus (paremal) on omane looduslikule aluspinnale. 
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 2.2.4 Mis on neeldumine? 

Valgus mitte ainult ei peegeldu pindadelt, vaid ka neeldub. Valguse neeldunud energia salvestatakse ja vabastatakse aeglaselt 
soojusena.  

Seda näeb ka igapäevaelus. Näiteks must T-särk neelab palju rohkem päikesevalgust kui valge. Sellepärast higistame musta 
särgiga rohkem kui valgega. 

2.2.5 Pildid kui arvuvõred 

Satelliitidelt saadud andmed paigutatakse ridadesse ja veergudesse. Neid nimetatakse ka rasterandmeteks. 

 

Joonis 9. Andur salvestab andmed numbritena. 

Numbrid näitavad valguse peegeldumise intensiivsust. Heledad pinnad peegeldavad tavaliselt suure intensiivsusega ja neil on 
suur numbriline väärtus, samas kui tumedad pinnad neelavad rohkem valgust ja seetõttu peegeldavad vähem. Mustade 
objektide puhul võib see olla päris null. 

2.2.6 Maa seire meetodid 

Maa seire andureid võib kinnitada nii satelliitide kui lennukite külge. Andurid töötavad kas passiivselt päikesevalguse abil või 
aktiivselt, st kiirgavad ise mikrolaineid (joonis 10). 

 

Joonis 10. Maa seire passiivsed ja aktiivsed salvestussüsteemid. 
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Lennuki külge kinnitatavad andurid asuvad maapinnale üsna lähedal ja seetõttu on andmed väga hea ruumilise eraldusvõimega. 
Kuid lennukid saavad lennata ainult üle väikese osa Maa pinnast, nii et neid kasutatakse enamasti eriuuringuteks. 

2.3 Mis on resolutsioon? 

2.3.1 Ruumiline resolutsioon (eraldusvõime) 

Pilt jagatakse ruudukesteks, mida nimetatakse piksliteks. Ruumiline lahutus on defineeritud kui pildi ühe piksli suurus, mis esindab 
mõõdetud ala pindala anduri vaateväljas (näiteks ruutmeetrites). Kõrge ruumilise resolutsiooniga on näha rohkem detaile (nt 
joonis 11). 

 

Joonis 11. Näiteid erineva resolutsiooni kohta. 

Lähestikku asuvad objektid satuvad sageli samasse pikslisse. Seda nimetatakse segapiksliks. Joonisel 12 näeme, kuidas objektide 
värvikomponendid segunevad ja luuakse segapiksel. Mida madalam on ruumiline eraldusvõime, seda rohkem segapiksleid 
luuakse ja seda vähem objekte saab üksteisest eristada. 

 

Joonis 12. Segapikslite moodustamine. 
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2.3.2 Ajaline resolutsioon 

Lisaks ruumilisele resolutsioonile on oluline roll ka ajalisel resolutsioonil. See näitab, kui pika ajavahemiku tagant tehakse sama 
piirkonna kohta järgmine satelliidipilt. Sõltuvalt orbiidist võib see olla 15 minutit kuni mitu nädalat. See sõltub satelliidi andmete 
kasutamise eesmärgist. Näiteks looduskatastroofide puhul on infot vaja võimalikult kiiresti. 

2.3.3 Spektraalne resolutsioon 

Satelliidiandurid kasutavad Maa pinnalt peegeldunud valgust. Mis värvi on valgus tegelikult? Kui vaatame valgust läbi prisma, 
siis näeme, et valgus jaguneb punaseks, roheliseks ja siniseks. Kõik ülejäänud värvid koosnevad nendest kolmest nn põhivärvist. 
Kollane koosneb näiteks rohelisest ja punasest. 

2.4 Miks me tajume asju värviliselt? 

Kui nähtav valgus jõuab värvilise pinnani, siis mõned lainepikkused neelduvad ja teised peegelduvad. Näiteks punane õun 
neelab rohelist ja sinist valgust ning peegeldab punast. Roheline leht seevastu neelab punast ja sinist ning peegeldab rohelist. 
Valged pinnad peegeldavad kõiki kolme lainepikkust samal määral, samas kui mustad pigmendid neelavad kõik kolm 
lainepikkust täielikult. Kõik teised värvid on loodud punase, rohelise ja sinise valguse koostoimel. Niimoodi muudavadki meid 
ümbritsevad objektid neeldumise ja peegeldumise kaudu valge päikesevalguse abil maailma värviliseks. 

Joonis 13. 

Peegeldumine ja 

neeldumine. 

Kas satelliidid 
tajuvad ka 

maapinda 
värviliselt? 

Satelliidiandurid näevad Maad hallina. Sest iga lainepikkuse vahemik registreeritakse eraldi nn kanalites. Lisaks nähtava valguse 
kanalitele (punane, roheline, sinine) on enamikul satelliitidel ka inimsilmale nähtamatud infrapunavalguse kanalid, ja mõnel 
satelliidil isegi ultraviolettvalguse kanalid. 

Satelliidi salvestuskanalite arvu nimetatakse spektraalseks eraldusvõimeks. Mida rohkem kanaleid on Maa seire anduril, seda 
suurem on satelliidi spektraalresolutsioon. 

Satelliit loob igas kanalis pildi, mis koosneb erinevatest hallidest toonidest, mistõttu seda nimetatakse ka hallskaala kujutiseks. 
Kui pind peegeldab palju punast valgust, näiteks tenniseväljakud, paistab see pind punase kanali halli skaala kujutisel täiesti 
valge ja rohelisel kanalil must. 
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2.5 Mida võib üks pilt meile öelda? 

2.5.1 NDVI (normaliseeritud vegetatsiooniindeks) 

Terved taimed peegeldavad tugevalt infrapunavalgust, kuid peaaegu üldse mitte punast valgust. Seetõttu saab taimi uurida 
NDVI abil, mida arvutatakse järgmiselt: 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 =
𝐼𝐼𝐼𝐼 − 𝑅𝑅𝑅𝑅𝑅𝑅
𝐼𝐼𝐼𝐼 + 𝑅𝑅𝑅𝑅𝑅𝑅

 

IR – infrapunavalgus 

RED – punane valgus 

 

Joonis 14. NDVI pilt Vahemerest 

2.5.2 Klassifitseerimine 

Klassifitseerimiseks nimetatakse sarnaste omadustega pikslite rühmitamist temaatilistesse klassidesse. Joonisel 15 näime, kuidas 
veele ja taimestikule värvi määramine lihtsustab piltide tõlgendamist. 
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Joonis 15. Värvidel põhinev klassifitseerimine. 

Klassifitseerimise abil saame maapinda esitada lihtsustatud viisil. Näiteks saame luua temaatilisi kaarte, kus on näidatud sellised 
klassid nagu asula, vesi ja mets. 

2.5.3 Muutuste analüüs 

Muutuste analüüsiga tuuakse esile mitte ainult maapinna praegune seisund, vaid ka selle muutumine aja jooksul. Joonisel 16 on 
kaks klassifitseeritud satelliidikujutist Bonni/Reini-Siegi piirkonnast kahel erineval ajahetkel. Kolmas pilt näitab muutust. 

 

Joonis 16. Muutuste analüüs 

3 Copernicus – Maa seire kõigile! 
Copernicuse programm on Euroopa Maa seire programm, mille raames ehitatakse võimsat taristut Maa satelliidipõhiseks 
seireks. Programmi haldab Euroopa Komisjon, tehnilise koordineerimise eest vastutab Euroopa Kosmoseagentuur (ESA). 
Kogutud ja töödeldud andmed on vabalt kättesaadavad kõigile inimestele. See toetab uute rakenduste ja teenuste 
väljatöötamist kogu maailmas. 

Copernicuse põhiteenused on maismaa ja mere seire, katastroofide ja kriiside ohjamine, atmosfääri seire, kliimamuutuste seire 
ja julgeoleku toetamine. Kõik teenused kasutavad Sentinel satelliidipilte. Lisainfo saamiseks kasutatakse kolmandate osapoolte 
andmeid. Selleks, et ametiasutused, teadlased, ettevõtted, organisatsioonid ja kodanikud saaksid Copernicuse andmeid 
kasutada, tuleb neid eelnevalt töödelda. Selleks ongi olemas Copernicuse teenuseid. 

Copernicuse programm aitab leevendada sotsiaalseid probleeme, kliimamuutusi, looduskatastroofe jne. Rakendusvaldkondi 
laiendatakse pidevalt edasi läbi teadusuuringute ja koostöö tööstusega. 

Teave Copernicuse programmi kohta 

Ametlik brošüür „Copernicus: Euroopa vaade Maale“: https://www.copernicus.eu/sites/default/files/2018-
10/Copernicus_brochure_DE_web_Oct2017.pdf  

Copernicuse programm Saksamaal: https://www.d-copernicus.de/  

https://www.copernicus.eu/sites/default/files/2018-10/Copernicus_brochure_DE_web_Oct2017.pdf
https://www.copernicus.eu/sites/default/files/2018-10/Copernicus_brochure_DE_web_Oct2017.pdf
https://www.d-copernicus.de/
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Sentinel-Online: https://sentinels.copernicus.eu/web/sentinel/home  

Copernicuse programm keskkonnaseireks: 

https://www.d-copernicus.de/fileadmin/Content/pdf/Tutorial_Copernicus_online.pdf  

3.1 Teenused 

Atmosfääriseire teenus on saadaval alates 2015. aasta juunist. Keskendutakse viiele peamisele valdkonnale – õhukvaliteet ja 
atmosfääri koostis, osoonikiht ja ultraviolettkiirgus, heitkogused, päikesekiirgus ja kliimamõjud. Oluliseks koostööpartneriks on 
Euroopa Keskpika Ilmaennustuse Keskus (ECMWF). 

Atmosfääriseire teenuse kataloog: 

https://www.copernicus.eu/sites/default/files/documents/Copernicus_AtmosphereMonitoring_Feb2017.pdf  

Merekeskkonna seire teenus pakub regulaarseid andmeid ookeanide ja mereökosüsteemide füüsikalise ja biogeokeemilise 
seisundi, varieeruvuse ja dünaamika kohta alates 2015. aasta maist. Rakendusvaldkondadeks on nt mereohutuse suurendamine 
(hoovuste ja tuulte täpsema prognoosi abil), ressursside kaitse, kliimamuutuste mõju uurimine ookeanidele. Teenuse 
koostööpartner on mittetulundusühing Mercator-Océan. 

Merekeskkonna seire teenuse kataloog: 

https://www.copernicus.eu/sites/default/files/documents/Copernicus_MarineMonitoring_Feb2017.pdf  

Maismaaseire teenus on saadaval alates 2012. aastast. Seiratakse biofüüsikalisi parameetreid (nt mullaniiskus), maakatet ja 
maakasutust (nt linnamaa vs põllumajandusmaa) ja päevakajalisi nähtusi (nt looduskatastroofe). Töötatakse välja maalihete seire 
võimalusi. Oluline koostööpartner on Euroopa Keskkonnaagentuur. 

Maa seire teenuse kataloog: 

https://www.copernicus.eu/sites/default/files/Copernicus%20Land%20Monitoring%20Service%20factsheet%20status%20okto
ober%202018.pdf  

Copernicuse kliimamuutuste teenus (C3S) kogub teavet mineviku, oleviku ja tuleviku kliima kohta. Eesmärk on toetada ELi 
kohanemis- ja leevendamispoliitikat. Kogutud andmeid kasutatakse näiteks selleks, et hinnata kliimamuutuste mõju 
bioloogilisele mitmekesisusele, esmatarbekaupade kättesaadavusele või veemajandusele. Kliimaandmete kogu (CDS) on 
kättesaadav kõigile kasutajatele. Teenus täiendab ELi olemasolevaid meteoroloogia- ja keskkonnateenuseid.  

Koostööpartner on Euroopa Keskpika Ilmaennustuse Keskus (ECMWF).  

Kliimaandmete kogu (CDS): https://cds.climate.copernicus.eu/#!/home  

Julgeoleku teenus on kättesaadav alates 2015. aastast ja toetab kolme valdkonda: piirivalvet, mereseiret ja ELi välispoliitikat. 
Piirivalve eesmärk on vähendada ebaseaduslike sisserändajate arvu, vähendada merel hukkuvate inimeste arvu, suurendada ELi 
sisejulgeolekut ja võidelda piiriülese kuritegevuse vastu. Mereseire ülesanne on toetada Euroopa meresõiduohutust. See 
puudutab muu hulgas laevanduse ohutust, aga ka kontrolli kalanduses ja võitlust merereostuse vastu. Välispoliitika eesmärk on 
toetada kriisiolukordades olevaid kolmandaid riike ning vähendada ülemaailmseid ja suuri piirkondi haaravaid ohte.  

https://sentinels.copernicus.eu/web/sentinel/home
https://www.d-copernicus.de/fileadmin/Content/pdf/Tutorial_Copernicus_online.pdf
https://www.copernicus.eu/sites/default/files/documents/Copernicus_AtmosphereMonitoring_Feb2017.pdf
https://www.copernicus.eu/sites/default/files/documents/Copernicus_MarineMonitoring_Feb2017.pdf
https://www.copernicus.eu/sites/default/files/Copernicus%20Land%20Monitoring%20Service%20factsheet%20status%20October%202018.pdf
https://www.copernicus.eu/sites/default/files/Copernicus%20Land%20Monitoring%20Service%20factsheet%20status%20October%202018.pdf
https://cds.climate.copernicus.eu/#!/home
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Koostööpartnerid on Euroopa Komisjon FRONTEX (Euroopa rannikuvalve), Euroopa Meresõiduohutuse Amet (EMSA) ja 
Euroopa Liidu Satelliidikeskus (EU SAtCen). 

Turvateenistuse kataloog: 

https://www.copernicus.eu/sites/default/files/documents/Copernicus_Security_oktoober2017.pdf  

Hädaolukordade ohjamise teenuse (EMS) kaudu saavad volitatud kasutajad kätte kriiside kaardid ja analüüsid. Näiteks saab 
teavet mingi piirkonna (või inimgrupi) haavatavuse kohta (enne katastroofi), operatiivinfot kriisijuhtimiseks (katastroofi ajal) ning 
katastroofi ulatuse ja taastamisvajaduste kohta (pärast katastroofi). Katastroofiks võib olla nt üleujutus, maavärin, metsatulekahju 
või humanitaarkriis. 

Ligipääsu EMSi teenusele saab taotleda keskusest nimega Joint Federal and State Reporting and Situation Center (GLMZ). 

Hädaolukordade ohjamise teenuse kataloog: 

https://www.copernicus.eu/sites/default/files/documents/Copernicus_Security_oktoober2017.pdf  

https://emergency.copernicus.eu/  

3.2 Andmeruum 

Copernicus Dataspace Ecosystem on Euroopa Komisjoni poolt käivitatud digitaalne keskkond, mis võimaldab vaba ligipääsu 
Sentineli missioonide andmetele ja paljule muule. Satelliidiandmeid saab otsida, analüüsida, visualiseerida ja alla laadida. Maa 
seire andmekogumeid on võimalik kasutada ka selliste veebiteenuste kaudu nagu openEO ja SentinelHub. 

Ametlik veebisait: https://dataspace.copernicus.eu/  

Youtube'i video (ametlikust koduleheküljest): https://youtu.be/Am93Xi0PZ5o  

3.3 SNAP 

SNAP (ESA Sentineli rakendusplatvorm) on Copernicuse tarkvara, mille töötasid välja Brockmann Consult, Skywatch, Sensar ja 
C-S. Programmi ja töövahendeid saab kasutada Maa seireandmete töötlemiseks ja analüüsimiseks. SNAP-i saab tasuta alla 
laadida ja kasutada igaüks. 

ESA teabeleht: https://earth.esa.int/eogateway/tools/snap  

Link allalaadimiseks: https://step.esa.int/main/download/snap-download/  

3.4 Andmetöötlus Dataspace Hubis 

3.4.1 Muutuste tuvastamine 

1. Minge veebisaidile https://dataspace.copernicus.eu/ ja valige ülevalt Copernicus Browser (Copernicuse veebilehitseja). 
2. Registreeruge või logige Copernicuse veebilehitsejasse (see on tasuta ja reklaame ei ole!). 
3. Andmete allalaadimiseks valige vasakul vahekaart nimega SEARCH (otsi). 

https://www.copernicus.eu/sites/default/files/documents/Copernicus_Security_October2017.pdf
https://www.copernicus.eu/sites/default/files/documents/Copernicus_Security_oktoober2017.pdf
https://emergency.copernicus.eu/
https://dataspace.copernicus.eu/
https://youtu.be/Am93Xi0PZ5o
https://earth.esa.int/eogateway/tools/snap
https://step.esa.int/main/download/snap-download/
https://dataspace.copernicus.eu/
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4. Uuritava asukoha määramiseks kirjutage paremal otsingu aknas (  Go to Place) „Zhoukou“. 
5. Valige Zhoukou, Hiina; linna nägemiseks suumige sisse. 
6. Nüüd valige andmeallikas. Selleks valige vasakul DATA SOURCES → Sentinel-2 → MSI → L2A. Nüüd saate atmosfääri 

suhtes korrigeeritud pildi. Pilvkatte liugur libistage 10%-ni.  
7. Muutuste tuvastamise puhul tuleb valida üsna suure ajavahega pildid. Vanimad pildid Zhoukou linna kohta on 

saadaval 2017. aasta aprillist. Pange otsingusse 1. aprill 2017 kuni 30. aprill 2017. 

 

Joonis 17. Uuritava paiga ja andmeallika valimine. 

8. Klõpsake tulemuste loetelust mõnel pildil ja kontrollige üksikasju. Piltide arv sõltub sellest, kui lähedale te suumisite, st 
kui mitu pilti vaatevälja mahub. Piltide nimed on väga sarnased, sest pärinevad samast salvestusribast. Laadige alla 
pilt:  
S2A_MSIL2A_20170428T030541_N0500_R075_T50SKC_20231114T174920.SAFE 

9. Korrake otsingut (Go to search) kuupäevadega 2024-04-01 kuni 2024-04-30 (alustage viimasest kuupäevast, sest 
muidu ei saa esimest muuta). 

Joonis 18. 
Satelliidipiltide allalaadimine. 

10. Laadige samast piirkonnast alla pilvevaba pilt 
S2B_MSIL2A_20240426T030519_N0510_R075_T50SKC_20240426T062656.SAFE 

11. Pakkige allalaaditud zip failid lahti. 
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Piltide analüüsimine SNAP-is  
12. Laadige omale SNAP programm alla aadressilt: https://step.esa.int/main/download/snap-download/ ja avage 

programm oma arvutis. 
13. Failide avamiseks vajutage vasakul üleval ääres kausta sümbolil. Valige allalaaditud lahtipakitud piltide kaustad ja 

avage mõlemas SAFE kataloogis fail „MTD_MSIL2A.xml“. 

 

 Joonis 19. Failide avamine. 

14. Minge pildi nime peale ja vajutage hiire paremat klahvi, valige Open RGB Image Window. Veenduge, et valitud on 
Sentinel 2 MSI Natural Colors ning punase joaks B4, rohelise jaoks B3 ja sinise jaoks B2 kanal. Klõpsake nuppu OK. 

 

Joonis 20. Faili avamine RGB formaadis. 

15. Piltide võrdlemiseks joondage need horisontaalselt (üleval sümboliribal nupp „Tile horizontally“ ).  

16. Kuna kogu pildi klassifitseerimine võtaks enamikus arvutites liiga kaua aega, valime meid huvitava piirkonna välja. 
Selleks Klõpsake ülemises menüüs Raster → Subset (alamhulk). 

17. Vahekaardil Spatial Subset (ruumiline alamhulk) saab määrata alamhulga piirid (vt numbreid järgmise pildi pealt). 
Ümber Zhoukou linna valime piirkonna Scene start X: 4490 Scene start Y: 1000 Scene end X: 5489 Scene end Y: 1999. 
Võrdlusribaks jätame B1. 

NB! 2010. aasta rahvaloendusel oli selles piirkonnas umbes 340 000 elanikku. Mitmed lähestikused linnad on kokku 
kasvanud.  

https://step.esa.int/main/download/snap-download/
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Joonis 21. Ruumilise alamhulga määramine. 

18. Vahekaardil Band Subset (vt järgmist pilti) valige ainult ribad 2–8 ja 11–12, mis on 10–20 m resolutsiooniga ribad 
nähtavas ja lähiinfrapunavalguses. Vaikimisi on valitud kõik ribad. Kõigepealt tuleb see tühistada: Select none ja 
seejärel valige pildil näidatud ribad.  

 

Joonis 22. Ribade määramine 

19. Tühistage vahekaardil Tie-point Grid Subset vaikimisi valikud: Select none, sest neist ükski pole klassifitseerimiseks 
vajalik. Vajutage OK. Tulemus kuvatakse vasakul üleval olevas Product Exploreri aknas. Valige samamoodi alamhulk ka 
teisel pildil. 

20. Enamik klassifitseerimisalgoritme nõuab, et ribadel oleks sama resolutsioon ja ulatus. Kuna mõnel alamhulga ribal on 
resolutsioon 10 m ja teistel 20 m, tuleb need ühtlustada. Selleks valige Raster → Geometric → Resampling. 
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Joonis 23. Resolutsioonide ühtlustamine 

21. Valige vahekaardil I/O Parameters (sisend- ja väljundfaili parameetrid) sisendfailiks 2017. aasta fail. Väljundfaili nime 
saate lühendada, nt võite panna: S2A_MSIL2A_20170428T030541_Zhoukou_20m 

22. Valige vahekaardil Resampling parameters (uue resolutsiooni määramise parameetrid) referentsribaks (By reference 
band from source product) B5. 

23. Valige teisendamise algoritmiks (Define resampling Algorithm) keskmistamise meetod (Downsampling method → 
Mean). Klõpsake nuppu Run (Käivita). Korrake resolutsiooni muutmist 2024. aasta alamhulga failiga. 

24. Enne klassifitseerimise alustamist tuleb alamhulgad uuesti projekteerida (tegeleme edasi uue resolutsiooniga 
failidega). Selleks valige Raster → Geometric → Reprojection. 

25. Valige vahekaardil I/O Parameters (sisend- ja väljundfaili parameetrid) sisendfailiks 2017. aasta alamhulk laiendiga 
resampled. Väljundfaili nime saate lühendada, aga jätke viimaseks sõnaks vaikimisi pakutud reprojected. Veenduge, et 
see on kirjutatud teiste andmetega samasse kausta. 

26. Vahekaardil Reprojection parameters kontrollige, kas projektsioon on „Geographic Lat/Lon (WGS 84)“. Kõik muud 
seaded võivad jääda selliseks, nagu nad on. Klõpsake nuppu Run (Käivita). Tehke sama 2024. aasta failiga. 

27. Avage mõlemad pildid loomulikes värvides: Open RGB Image Window → Sentinel 2 MSI Natural Colors. Kui teil on 
korraga lahti mitu pilti, saate neil vahet teha nime ees oleva numbri järgi. 

28. Ümberprojekteerimise tõttu näevad pildid teistsugused välja. Tühjad nurgad on samuti klassifitseeritud ja see 
moonutab tulemust. Seepärast lõikame need ära. Kordame alamhulga loomise protsessi (vt 17–19). Seekord paneme 
järgmised koordinaadid:  
Scene start X: 50  
Scene start Y: 50  
Scene end X: 1149  
Scene end Y: 949  
Ribad ja metaandmed jäävad seekord samaks, neid ärge muutke. 
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29. Nüüd on 2017. aasta ja 2024. aasta piltide kohta tehtud alamhulgad, seejärel ühtlustatud resolutsioon, 
ümberprojekteeritud ja määratud uuesti alamhulgad. Salvestage mõlemad töödeldud pildid Product Explorer aknas 
(parem hiireklõps ja avaneb valik Save Product). Veenduge, et failid lähevad õigesse kataloogi. 

Klassifikatsioon 
SNAPis on erinevaid klassifitseerimismeetodeid. Üks võimalus on lasta tarkvaral ise otsustada, mis millega kokku käib, seda 
nimetatakse juhendamata klassifitseerimiseks. Kui kasutaja määrab ise, millised pikslid kokku kuuluvad, siis seda nimetatakse 
juhendatud klassifitseerimiseks. Kui soovime kahte ajaperioodi võrrelda, siis peaksime kasutama viimast, sest juhendamata 
klassifitseerimise puhul ei ole kaks tulemust omavahel võrreldavad. 

30. Juhendatud klassifitseerimiseks vajab tarkvara näiteid eri klasside kohta (1. linnapiirkond 2. viljatu maa, 3. taimestik ja 
4. vesi). Loomulikes värvides pildil võib olla neid raske eristada. Aga meil on võimalik kasutada ka teisi võimalusi, nt 
Healthy Vegetation pilti, kus taimed helendavad punaselt. Selleks minge faili nime peale, parem hiireklõps Open RGB 
Image Window ja valige Profile: Sentinel 2MSI Healthy Vegetation. 

 

Joonis 24. Sama piirkond loomulikes värvides pildil ja taimestiku tervist näitaval pildil. 

31. Tarkvarale antud näited peavad olema nö puhtad pikslid, st ei tohi sisaldada ühegi teise klassi piksleid. Näidisalad 
loome vektoritena. Selleks klõpsake ülaosas tööriistaribal Vector → New Vector Data Container ja andke sellele nimi.  

32. Kasutage tööriistariba nuppe  selleks, et lisada klasse ja näitepiirkondi.  

33. Iga klassi puhul veenduge, et valitud piirkonnad oleksid „puhtad“, st esindatud oleksid ainult valitud klassi kuuluvad 
pikslid (nt majade vahel poleks puid, põldude vahel teid jne). Iga piksel loeb! 
Vihjed: Hiinas peetakse punast ja sinist katust õnnetoovateks. Lisage need oma linnaklassi, kuid veenduge, et nende 
vahel ei oleks puid. Linnapiirkondade alla võiks teha ka tööstuspiirkonna alamklassi. 

34. Kui olete rahul kõigi nelja klassi võrdlusaladega (piisab 5–6 väikesest hulknurgast!), salvestage pilt (parem hiireklõps 
Save Product). 

35. Kui loote teisel pildil näidisalasid, siis kasutage kindlasti samu klasse. Kui alad pole vahepeal muutunud, siis võite 
hulknurgad sättida enam-vähem samadesse kohtadesse. Lõpuks kindlasti salvestage. 
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36. Kui mõlemad pildid on koos näidisaladega salvestatatud, valige menüüst Raster → Classification → Supervised 
Classification → Random Forest Classifier. 

 

Joonis 25. Metsa klassifikatsiooni määramine. 

37. Avanevas aknas klõpsake suurel plussmärgil ja valige 2017. aasta näidisaladega fail. 

38. Vahekaardil Random Forest Classifier (Juhuslik metsaklassifikaator) vähendage proovialade arvu 5000lt 1000le. 

39. Valige Vektorikoolituses (Vector Training) kõik klassid (vt joonis). Seejärel kerige vajadusel allapoole ja valige kõik 
ribad (2–12). 

 

Joonis 26. Juhuslik metsa klassifikaator. 



 
28 

 

40. Minge vahekaardile Write ja veenduge, et failil on sobiv nimi ja kataloog. Seejärel klõpsake nuppu Run (Käivita). 

41. Korrake sama protsessi 2024. aasta näidisaladega failiga. Seejärel vajutage failile kaks klõpsu ning avage mõlema 
toote juures LabeledClasses. 

42. Allpool peaks olema paista värvide muutmise aken (Color Manipulation). Kui seda ei paista, siis valige menüüst View 
→ Tool windows →Color Manipulation. 

43. Siin saate muuta klasside värve (vt joonis). 

 
Joonis 27. Värvide muutmine 

44. Pange mõlemas failis klassidele samad värvid. 

45. Võrrelge, kui palju on mingi klassi väärtusi 2017. ja 2024. aastal. Kuidas on see seitsme aastaga muutunud? 

46. Võrrelge linnapiirkonda aastatel 2017–2024. 

 

Joonis 28. Linnapiirkonna võrdlemine 



 
29 

 

Näidistulemus 

Klass Värvus Esinemine 2017. aastal Esinemine 2024. 
aastal 

Vesi   0,75% 0,7% 

Taimestik   77,7% 66,1% 

Hoonestatud ala   19,9% 30% 

Viljatu maapind   1,7% 3,2% 

 

Seitsme aasta jooksul laienes vaadeldavas piirkonnas ehitiste all olev ala ligikaudu 10% (kahekümnelt protsendilt 
kolmekümnele). Hoonestatud ala suurenes seega poolteist korda. Taimkattega ala vähenes 11,5%, viljatu maapinna osakaal 
peaaegu kahekordistus 1,7%-lt 3,2%-le. Lähemal vaatlusel selgub, et 2024. aastal on edelaosas arvukalt põlde, mis on 
tõenäoliselt just koristatud või värskelt istutatud. Linnapiirkondades esinevad piklikud alad aga näitavad ehitusplatse. Veealade 
osakaal ja jaotus on muutunud vaid vähesel määral ning on tõenäoliselt tingitud vooluveekogude erinevast veetasemest. 

Märkus: Selleks, et saada täpne teaduslik analüüs, oleks vaja teha täiendavaid analüüse. 

3.4.2 Kas jalgpalliväljakul on kunstmuru või looduslik muru? 

Bioloogia valdkonna näide 

NDVI (normaliseeritud taimestiku indeks) annab meile teavet taimede tervise kohta. See võimaldab ka vaadata, kas piirkonnas 
on tõelisi taimi või on seal kunsttaimed (nt kunstmuru). Loomulikes värvides pildi puhul on väga keeruline eristada, kas 
jalgpalliväljakul on looduslik muru või kunstmuru. NDVI pildil peegeldab looduslik muru valgust lähisinfrapuna piirkonnas 
tugevamalt kui kunstmuru (vt joonis 29). 

 

Joonis 29. Loomulikes värvides pilt (vasakul) ja NDVI pilt (paremal). 

 

Andmete kogumine 

Sentinel-2-l on nähtava, lähisinfrapuna ja infrapuna kiirguse salvestamiseks 13 riba. NDVI arvutamiseks kasutatakse punaseid 
ja lähisinfrapunaseid ribasid.  
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Teeme loomulike värvide ja NDVI pildi võrdluse Copernicuse brauseris. Selleks kasutame andmepäringut ja analüüsi.  

1. Avage brauser: https://browser.dataspace.copernicus.eu/ ja logige sisse. Klõpsake paremal väljale SEARCH ja 
sisestage vasakul otsinguväljale „Kapfenberg Austria“. Suumige linn sisse. 

 

Joonis 30. Copernicuse brauseri satelliidipildi päring  

 

2. Valige Sentinel-2, sättige pilvede katvuse protsendiks 15 või vähem. 

3. Valige piisavalt pikk ajavahemik, et saada piisavalt pilvevabu pilte. 

4. Klõpsake rohelisel nupul Search. 

5. Valige üks tulemustest, klõpsates pildi all väiksel nupul Visualize (Visualiseeri).  

6. Vajadusel kohandage oma otsinguparameetreid. 

7. Kui satelliidipilt on visualiseeritud (see võib võtta aega), valige Layers (kihid) alt NDVI.  

8. Klõpsake Add to → Add to Compare (lisa võrdlemiseks). 

9. Nüüd valige loomulike värvidega kiht (True color) ja korrage sammu nr 8.  

https://browser.dataspace.copernicus.eu/
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Joonis 31. Loomulike värvidega kihi valimine. 

10. Piltide võrdlemiseks klõpsake nupul . 

11. Piirkonna täpsustamiseks saate kasutada liugureid (vt joonis 32). Otsige üles Kapfenbergi jalgpalliväljakud (vajadusel 
kasutage Google Mapsi), abiks võib olla joonis nr 1. 

 

Joonis 32. Jalgpalliväljakute võrdlus. 

12. Saadud pildi allalaadimiseks klõpsake joonisel 5 kollase noolega näidatud sümbolil. 
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Joonis 33. Pildi allalaadimine Copernicus brauseris. 

3.4.3 Soojus Hispaanias 

Geograafia valdkonna näide 

1. Minge veebisaidile https://dataspace.copernicus.eu/ ja valige Copernicus Browser (Copernicuse veebilehitseja). 

2. Registreeruge või logige sisse Copernicuse veebilehitsejasse (see on tasuta ja reklaame ei ole!) 

3. Andmete allalaadimiseks valige vasakul vahekaart SEARCH (otsi). 

4. Uuritava asukoha määramiseks kirjutage paremal otsingu aknas (  Go to Place) „Madriid“. 

5. Valige Madriid Hispaanias, suumige nii, et linn asuks ekraani keskel ja nii üles kui alla jääks veel umbes linna jagu 
ruumi (siis mahuvad pildile vajalikud satelliidipildid). 

6. Vasakul menüüs valige andmeallikaks Sentinel-3 → SLSTR (termiline infrapunaandur) → Level-2 LST (maapinna 
temperatuur). 

7. Et saada ainult päevase aja pilte, vajutage Sentinel-3 kõrval ning sealt filtrite alt valige Non Time Critical ja 
Descending. 

https://dataspace.copernicus.eu/
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Joonis 34. Filtrite valimine 

8. Ajavahemikuks määrake 2023-07-10 kuni 2023-07-11 ja klõpsake Search 

 

Joonis 35. Ajaperioodi valik. 

9. Teile kuvatakse selles ajavahemikus selles piirkonnas tehtud satelliidipiltide loend. Märkate, et mõned pildid katavad 
Hispaaniat paremini kui teised, aga kunagi ei kata üks pilt tervet riiki. 

10. Uurige kuvatud satelliidipilte, proovige välja mõelda, mida piltidel kuvatakse ja millise värviga edasi antakse. Näete, et 
11. juuli pildil on veidi pilvi. 
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11. Laadige alla kaks pilti:  
 S3B_SL_2_LST___20230710T103317...  

S3B_SL_2_LST____20230710T103017... 
 

 

Joonis 36. Piltide allalaadimine. 

12. Pakkige pildid lahti. 

Vaatame pilte SNAPis 

13. Avage SNAP. 

14. Avage mõlema pildi alt fail „xfdumanifest.xml“. 

 

Joonis 37. Failide avamine. 
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15. Sisu avamiseks klõpsake Product Exploreris faili nime ees olevale väikesele noolekesele (vt joonis), sealt edasi valige 
Bands ja tehke topeltklõps valikul „LST“. Tehke sama asi läbi teise failiga. 

 

Joonis 38. Pildi avamine. 

16. Kujutis avaneb halltoonides, aga selle muudame ära. 

17. Kui Product Explorer-i alumises kastis pole valikut Colour Manipulation, siis valige menüüst View → Tool windows 
→Color Manipulation. Valige Palette all sobivate värvidega palett, nt 5_colors. 

18. Kui vaatate numbrivahemikke (Range), siis märkate, et need on veidi suuremad kui 300. See on tingitud Kelvini 
kraadidest (273,15 °C + Celsiuse kraadid, sest arvestatakse absoluutsest nullist). Sellega tegelema järgmistes etappides. 

Mosaiigi loomine ja reguleerimine 

19. Valige menüüst Raster → Geometric → Mosaicking. 

 

Joonis 39. Mosaiikimise valimine. 
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20. Lisage vahekaardil I/O Parameters pluss nupuga kaks pilti samamoodi, nagu te need avasite. 

21. Veenduge, et märge Update targe product (uuenda tulemuse pilt) oleks märkimata. Andke oma mosaiigile uus nimi, 
mis ütleb teile hiljem selle sisu, nt IberianPeninsula_S3_LST_20230710T2023103317, mis sisaldab asukohta, satelliidi 
nime, toote nime ning kuupäeva ja kellaaega. 

22. Kataloogi valimiseks klõpsake kolme punktiga nupul ja liikuge kausta, kus on SEN3-failid. Seejärel klõpsake nuppu 
Select. 

23. Vahekaardil Map Projection Definition muutke projektsiooni väärtuseks UTM / WGS 84 (Automatic). 

24. Mosaiigi piiride (Mosaic Bounds) juures valige kaardiaknas ainult Pürenee poolsaar. 

25. Muutke punast kastikest nii, et see hõlmaks ainult huvipakkuvat ala: Pürenee poolsaare piirid peaksid olema umbes: 
Läänes: –10° ida suunas: 3,5°  
Põhjas: 44,5° lõuna suunas: 35,5°  
Piksli suurus 1000 m võib jääda samaks.  

 

Joonis 40. Mosaiikimise piirkonna valimine. 

26.  Vahelehel Variables & Conditions (muutujad & tingimused) vajutage nupule . 

27. Selles ülesandes on vaja ainult LST-d ja NDVI-d, aga LST on vaja eelnevalt viia Celsiuse kraadidesse. Seepärast valime 
praegu ainult NDVI. 

28. Selleks, et LST kihti saada Celsiuse kraadides, teeme uue muutuja. Selleks tuleb muutujate (Variables) all vajutada 
plussile. 

29. Andke uuele muutujale nimi (nt LSTCelsius). 

30. Tehke topeltklõps valiku all Expression ja kirjutage avaldise väljale „LST - 273.15“ ja klõpsake nuppu OK. 
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Joonis 41. Mosaiikimine 

31. Klõpsake nuppu Run (käivita). 

32. Kuvatakse aken, mis teavitab teid faili edukast kirjutamisest ja avamisest SNAP-is. Võite klõpsata OK. Võite sulgeda ka 
Mosaiikimise akna. 

Tulemuste visualiseerimine 

33. Avage kausta Band alt LST-pilt. See peaks ilmuma hallides toonides. Valige sobiv värvipalett, nt 5_colors 

34. Värvitoone saate muuta valikuga Sliders (liugurid). 

35. Värvide muutmiseks või liigutamiseks võite klõpsata kolmnurkadel või muuta arvude väärtusi käsitsi. 

 

Joonis 42. Värvide muutmine. 

36. Avage kausta Band alt NDVI-pilt. See peaks ilmuma hallides toonides. NDVI pildile sobib hästi meris_veg_index palett. 

Selle valimiseks minge kõigepealt tagasi põhipalettide juurde: . Seejärel saate liugurite abil toone muuta. 

37. NDVI kõrged väärtused (0,6–0,8) viitavad tihedale metsale, mõõdukad väärtustele (0,2–0,3) rohule, põõsastikule või 
madalatele elujõulistele taimedele. Väga madalad väärtused (0,1 ja alla selle) vastavad viljatutele kalju-, liiva- või 
lumealadele. Negatiivsed väärtused (< 0) näitavad veekogusid. Järgmisel joonisel on toodud näide, kuidas 
meris_veg_index paletti on sobivamaks muudetud. 
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Joonis 43. NDVI väärtuste kohandamine. 

38. Piltide võrdlemiseks joondage need horisontaalselt (üleval sümboliribal nupp „Tile horizontally“).  

 

Joonis 44. Horisontaalselt joondamine 

Nüüd saate vaadata LST ja NDVI pilti kõrvuti ja näha, kuidas taimestik mõjutab pinnatemperatuuri. 

 

Joonis 45. Pinnatemperatuuri ja taimestiku võrdlus satelliidipiltidel. 

39. Piltide paigutamisel on abi vahekaardist Navigation  

3.4.4 Suessi kanal 

Füüsika valdkonna näide 
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1. Minge veebisaidile https://dataspace.copernicus.eu/ ja valige Copernicus Browser. 

2. Registreeruge või logige Copernicuse veebilehitsejasse (see on tasuta ja reklaame ei ole!). 

3. Andmete allalaadimiseks valige vasakul vahekaart nimega SEARCH (otsi). 

4. Määrake asukoht paremal otsingu aknas (  Go to Place) „Suess“. Valige Suess, Egiptus. 

5. Vasakul menüüs valige andmeallikaks Sentinel-1 → C-SAR → Level-1 GRD. 

 

Joonis 46. Andmekogu valimine. 

6. Ajavahemikuks määrake 2021-03-21 kuni 2021-03-27 ja klõpsake Search 

 

Joonis 47. Perioodi valimine. 

7. Laadige alla kaks pilti, mille seiramise ajad on: 

2021-03-27T03:44:10.127000Z 

https://dataspace.copernicus.eu/
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2021-03-21T03:44:49.598000Z 

8. Pakkige pildid lahti. 

9. Avage SNAP. 

10. Failide avamiseks klõpsake kausta sümbolil. Liikuge kausta, kuhu salvestasite lahti pakitud failid ja avage mõlema faili 
„manifest.safe“. 

 

Joonis 48. Failide avamine SNAP-is. 

11. Valige menüüst Raster → Geometric → Collocation. Esimeseks failiks (Master) valige fail kuupäevaga 21.03 ja teiseks 
(Slave) fail kuupäevaga 27.03. 

 

 

Joonis 49. Faili valimine. 

12. Pange väljundfailile nimi, nt „S1_EgiptusMärts2021_võrdlus“. 

13. Salvestamiseks valige lahtipakitud failide kataloog. 

14. Failide lõppu võiks lisada kuupäevad ja sõnad „enne“ ja „pärast“. 

15. Jätke kõik muud seaded muutmata ja klõpsake nupul Run (käivita). 
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Joonis 50. Seadistused kollokatsiooniks. 

16. Avage uus fail aknas Product Explorer (parema hiireklõpsuga Open RGB Image Window). 

 

Joonis 51. Faili avamine. 

17. Valige RGB aknas punase kanali jaoks Intensity_VH ja „enne“ ning rohelise ja sinise kanali jaoks Intensity_VH ja 
„pärast“ (vt joonist). 

 

Joonis 52. Intensity_VH seaded. 

18. Klõpsake nuppu OK. 
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19. Suumige sisse paremal pool asuvasse tumedamasse piirkonda. 

20. Tumedal alal (Punane meri) näete, et 21. märtsil on laevad punast värvi ja 27. märtsil helesinist värvi. Punased laevad 
läksid kanalist ilusti läbi, aga helesinine laev blokeeris 27. märtsil Suessi kanali. Ja paista on ka pikk laevade järjekord. 

3.5 Sentineli andmed arvutitundides 

Üleilmastumise käigus muutub Maa seire üha olulisemaks. Satelliidid koguvad iga päev tohutul hulgal andmeid, et anda teavet 
mitmesuguste rakenduste jaoks. Ainuüksi Copernicuse programm toodab iga päev umbes 12 TB andmeid. See teeb 
Copernicuse programmist suuruselt kolmanda andmepakkuja maailmas. Selle andmehulga haldamiseks ja töötlemiseks on vaja 
väga erinevate oskustega arvutiteadlasi. 

Selles peatükis anname erinevaid teoreetilisi ja praktilisi programmeerimisega seotud teadmisi. Näiteks teeme õpilastele selgeks, 
mida tähendab integreeritud programmeerimiskeskkond (IDE – Integrated Development Environment), liides ja 
rakendusprogrammeerimisliides (API). Õpilased loovad GeoJSON faile ning uurivad nende funktsioone ja struktuuri. Lisaks 
õpivad nad, kuidas programmeerida Pythoni APId, koostada IDEga päringut ja laadida alla satelliidiandmeid Copernicuse 
serveritest. 

Kasutajad vajavad andmemassiivide automatiseeritud töötlemist. Selle võimaldamiseks kasutatakse muuhulgas APIsid. API on 
programmeerimisliides, millega on võimalik vahetada andmeid programmide või tervete moodulite vahel standardiseeritud 
viisil. IDEsid kasutatakse selliste APIde programmeerimise lihtsustamiseks. Neil on kasutajaliides, mis sisaldab kõiki vajalikke 
tööriistu ja funktsioone erinevate programmeerimiskeelte jaoks. Need funktsioonid ja tööriistad hõlmavad näiteks lähtekoodi 
vormindamist või silurit. 

Täiendavad õppematerjalid leiate veebisaidilt http://www.esero.de/ ja http://fis.rub.de/. Muuhulgas pakub FIS interaktiivset 
õppemoodulit rasterandmete veergude ja ridade, binaarkoodi ja pildi bitisügavuse teemal. 

ESERO Germany pakub erinevaid õppematerjale arvutitundide jaoks. Sihtrühm on 8–20aastased ja sisu ulatub arvutivabast 
kontseptsiooniõpetusest kuni ARDUINO-l ja C++-l põhinevate programmideni, mis juhivad robotit. QR-koodid viivad teid otse 
õppematerjalide juurde.  

3.5.1 Pythoni API kasutamine 

Pythoni API programmeerimiseks tuleb arvutisse installida Pythoni versioon 2.7, 3.4 või uuem versioon. Installeerimisel tuleb 
aktiveerida võimalus kasutada paketihaldusprogrammi „pip“. Lisaks tuleb paigaldada „Sentinelsat” („pip” abil käsurealt 
(cmd.exe)). Lisateavet Sentinelsati, paigaldamise ja täiendava süntaksi kohta leiab aadressilt https://sentinelsat.readthedocs.io/. 

1. Avage käsurida.  

2. Installige pip-i abil „Sentinelsat“:  

pip install sentinelsat  

Vajutage Enter.  

Kontrollige, kas moodul on edukalt installitud.  

GeoJSONi faile kasutatakse uurimispiirkonna määramiseks. See on formaat, millega on võimalik salvestada geograafilise 
asukoha ja piirkonna andmeid JavaScript Object Notationi (JSON) abil. Koodi loomisel saate abi veebisaidilt www.geojson.io. 

http://www.esero.de/
http://fis.rub.de/
https://sentinelsat.readthedocs.io/
http://www.geojson.io/
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3. Külastage veebisaiti www.geojson.io  

4. Joonistage huvipakkuvale alale hulknurk. Antud juhul on välja valitud piirkond Bangladeshis.  

5. Valige kogu paremas aknas loodud kood. 

6. Kleepige tekst mis tahes tekstiredaktorisse ja salvestage fail laiendiga .geojson 

 

Joonis 53. Huvipakkuva piirkonna valimine veebisaidil www.geojson.io. 

Kõik edasised sammud tehakse IDEs. Selleks kasutasime PyCharmi Community-t. Visual Studio Code töötab ka hästi, kuid nõuab 
Pythoni interpretaatori paigaldamist. 

7. Avage sobiv IDE ja looge uus projekt.  

PyCharm loob projektikaustas automaatselt kõik asjakohased Pythoni failid. Kui on probleeme interpretaatoriga, valige File → 
Settings → Project → Project Interpreter. 

8. Lisage oma projektile uus skript. Selleks paremklõpsake projektil New Python File. Määrake nimi ja salvestage projekt.  

http://www.geojson.io/
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9. Importige kõik vajalikud librarid: 

from sentinelsat.sentinel import SentinelAPI, read_geojson, geojson_to_wkt 
  from datetime import date 

 

Joonis 54. Pythoni failide loomine PyCarm Community-s.  

10. Looge ühendus Copernicuse serveriga sisestades oma juurdepääsuandmed: 

api=SentinelAPI(’Username’,’Password’,’https://scihub.copernicus.eu/dhus’) 

Selleks, et hiljem oleks võimalik viidata juurdepääsuandmetele, kasutame muutujaid. Kuna paroolid on selles skriptis nähtavad, 
on soovitatav koostada õpilastele mingi hulk kontosid.  

11. Kopeerige äsja loodud GeoJSONi fail Pythoni skriptiga samasse kausta?  

12. Nüüd viidake GeoJSONi failile skriptis: 

footprint = geojson_to_wkt(read_geojson(’Sunderban.geojson’)) 

Järgnevalt tuleb kirjutada filter, mis valib välja ainult need satelliidipildid, mis vastavad teatud kriteeriumidele. Need kriteeriumid 
hõlmavad uurimispiirkonda (footprint), andmete kogumise kuupäeva, satelliiti, pilvisust ja töötlemistaset. Soovime keskenduda 
Sentinel-2 satelliidi andmetele, mida on juba eeltöödeldud. See tähendab, et pildil on juba tehtud atmosfääriparandusi. 
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13. Andmete filtreerimise kood võib välja näha nt selline: 

products = api.query(footprint, 
                    date=("20191101", date(2019, 11, 15)), 
                    platformname=’Sentinel-2’, 
                    processinglevel=’Level-2A’, 
                    cloudcoverpercentage=(0, 5)) 

14. Kui konsoolis tahetakse kuvada leitud toodete arv, võib kasutada sellist filtrit: 

print(’Gefundene Produkte: ’ + str(api.count(footprint, 
                                  date=("20191113", date(2019, 11, 15)), 
                                  platformname=’Sentinel-2’, 
                                  processinglevel=’Level-2A’, 
                                  cloudcoverpercentage=(0, 5)))) 

15. Lisaks saab kõigi leitud toodete suurust või nende metaandmeid väljastada GeoJSON-i kujul. Selleks on kood 
järgmine: 

# getting information about product size 
  print(str(api.get_products_size(products)) + ’GB’) 
  # getting geometric metadata from results 
  print(api.to_geojson(products)) 

16. Kui soovite kõik leitud tooted konkreetsesse salvestuskohta alla laadida: 

api.download_all(products, directory_path=’C:/Users/Public/Downloads’) 

17. Kui soovite alla laadida ainult ühte toodet, leiate selle UUID-e geomeetrilistest metaandmetest. Skript võib olla 
näiteks niisugune: 

api.download(’b063bb06-1b64-4dc5-9e0f-af5838725d29’) 

18. Käivitage oma skript. 

Näide kogu skripti kohta: 

from sentinelsat.sentinel import SentinelAPI, read_geojson, geojson_to_wkt 
  from datetime import date  

 #connect to the API 
  api=SentinelAPI(’Username’,’Password’,’https://scihub.copernicus.eu/dhus’) 

 #define Area of Interest (AOI) 

footprint = geojson_to_wkt(read_geojson(’Sunderban.geojson’)) 

 #set up query to filter data 
products = api.query(footprint, 
                    date=("20191101", date(2019, 11, 15)), 
                    platformname=’Sentinel-2’, 
                    processinglevel=’Level-2A’, 
                    cloudcoverpercentage=(0, 5))  

#getting information about the results 
  #getting number of results 
print(’Gefundene Produkte: ’ + str(api.count(footprint, 
                                  date=("20191113", date(2019, 11, 15)), 
                                  platformname=’Sentinel-2’, 



 
46 

 

                                  processinglevel=’Level-2A’, 
                                  cloudcoverpercentage=(0, 5)))) 

# getting information about product size 
  print(str(api.get_products_size(products)) + ’GB’) 
  # getting geometric metadata from results 
  print(api.to_geojson(products)) 

 #Download 
api.download_all(products, directory_path=’C:/Users/Public/Downloads’) 
  #Download via UUID 
api.download(’b063bb06-1b64-4dc5-9e0f-af5838725d29’) 

3.5.2 Andmekirje avamine SNAP-is 

SNAP (ESA Sentineli rakendusplatvorm) on Copernicuse tarkvara, mida saab tasuta alla laadida aadressil 
https://step.esa.int/main/download/snap-download/.  

1. Avage SNAP.  

2. Valige File → Open Product ... ja avage andmekogumi ZIP-kataloog.  

3. Paremklõpsake andmekogumil aknas Product Explorer ja valige Open RGB Image Window. 

Edasiseks töötluseks vaadake käsiraamatut: https://step.esa.int/main/doc/tutorials/. Võite otsida abi ka selle õppematerjali 
eelnevatest peatükkidest. 

 

  

https://step.esa.int/main/download/snap-download/
https://step.esa.int/main/doc/tutorials/
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Lisateave 
Copernicuse Akadeemia: https://www.copernicus.eu/et/opportunities/education/copernicus-academy  

Copernicuse programm: https://sentiwiki.copernicus.eu/web/copernicus-programm  

Virginia T. Norwood: Landsati ema: https://landsat.gsfc.nasa.gov/article/virginia-t-norwood-the-mother-of-landsat/  

  

https://www.copernicus.eu/et/opportunities/education/copernicus-academy
https://sentiwiki.copernicus.eu/web/copernicus-programm
https://landsat.gsfc.nasa.gov/article/virginia-t-norwood-the-mother-of-landsat/
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Jooniste pealkirjad 

Joonis 1: Hollandis IJsseli järvel asuv Fryslâni tuulepark. 

Joonis 2: Sau veehoidla murettekitavalt madal veetase.  

Joonis 3. Sentinel-3 poolt jäädvustatud vulkaanipurse 14. jaanuaril 2024 Islandil. 

Joonis 4. Õhukvaliteet Euroopas 22. Märtsil 2022. 

Joonis 5. Kuidas Maa seire toimib? 

Joonis 6. Elektromagnetlained kõrgetel ja madalatel sagedustel. 

Joonis 7. Elektromagnetspekter. 

Joonis 8. Kolme tüüpi valguse peegeldumine. Segapeegeldus (paremal) on omane looduslikule aluspinnale. 

Joonis 9. Andur salvestab andmed numbritena. 

Joonis 10. Maa seire passiivsed ja aktiivsed salvestussüsteemid. 

Joonis 11. Näiteid erineva resolutsiooni kohta. 

Joonis 12. Segapikslite moodustamine. 

Joonis 13. Peegeldumine ja neeldumine. 

Joonis 14. NDVI pilt Vahemerest. 

Joonis 15. Värvidel põhinev klassifitseerimine. 

Joonis 16. Muutuste analüüs. 

Joonis 17. Uuritava paiga ja andmeallika valimine. 

Joonis 18. Satelliidipiltide allalaadimine. 

Joonis 19. Failide avamine. 

Joonis 20. Faili avamine RGB formaadis. 

Joonis 21. Ruumilise alamhulga määramine. 

Joonis 22. Ribade määramine. 

Joonis 23. Resolutsioonide ühtlustamine. 

Joonis 24. Sama piirkond loomulikes värvides pildil ja taimestiku tervist näitaval pildil. 
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Joonis 25. Metsa klassifikatsiooni määramine. 

Joonis 26. Juhuslik metsa klassifikaator. 

Joonis 27. Värvide muutmine. 

Joonis 28. Linnapiirkonna võrdlemine. 

Joonis 29. Loomulikes värvides pilt (vasakul) ja NDVI pilt (paremal). 

Joonis 30. Copernicuse brauseri satelliidipildi päring. 

Joonis 31. Loomulike värvidega kihi valimine. 

Joonis 32. Jalgpalliväljakute võrdlus. 

Joonis 33. Pildi allalaadimine Copernicus brauseris. 

Joonis 34. Filtrite valimine. 

Joonis 35. Ajaperioodi valik. 

Joonis 36. Piltide allalaadimine. 

Joonis 37. Failide avamine. 

Joonis 38. Piltide avamine. 

Joonis 39. Mosaiikimise valimine. 

Joonis 40. Mosaiikimise piirkonna valimine. 

Joonis 41. Mosaiikimine. 

Joonis 42. Värvide muutmine. 

Joonis 43. NDVI väärtuste kohandamine. 

Joonis 44. Horisontaalselt joondamine. 

Joonis 45. Pinnatemperatuuri ja taimestiku võrdlus satelliidipiltidel. 

Joonis 46. Andmekogu valimine. 

Joonis 47. Perioodi valimine. 

Joonis 48. Failide avamine SNAP-is. 

Joonis 49. Failide valimine. 

Joonis 50. Seadistused kollokatsiooniks. 

Joonis 51. Failide avamine. 
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Joonis 52. Intensity_VH seaded. 

Joonis 53. Huvipakkuva piirkonna valimine veebisaidil www.geojson.io. 

Joonis 54. Pythoni failide loomine PyCarm Community-s 
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